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Preface
PREFACE

As part of an effort to improve its product lines, EMC periodically releases revisions of its 
software and hardware. Therefore, some functions described in this document might not 
be supported by all versions of the software or hardware currently in use. The product 
release notes provide the most up-to-date information on product features.

Contact your EMC technical support professional if a product does not function properly or 
does not function as described in this document.

Note: This document was accurate at publication time. Go to EMC Online Support 
(http://support.emc.com) to ensure that you are using the latest version of this document.

Purpose
This document describes how to configure and use the EMC® Monitoring and Reporting 
Suite.

Audience
This document is intended for VNX and VNXe storage administrators and IT generalists 
who will be involved in managing VNX Family Monitoring and Reporting.

Conventions used in this document
EMC uses the following conventions for special notices:

DANGER indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury. 

CAUTION, used with the safety alert symbol, indicates a hazardous situation which, if not 
avoided, could result in minor or moderate injury. 

NOTICE is used to address practices not related to personal injury.

Note: A note presents information that is important, but not hazard-related.
5
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IMPORTANT

An important notice contains information essential to software or hardware operation.

Typographical conventions

EMC uses the following type style conventions in this document:

Where to get help
EMC support, product, and licensing information can be obtained as follows:

Product information — For documentation, release notes, software updates, or 
information about EMC products, go to EMC Online Support at:

http://support.emc.com

Technical support — Go to EMC Online Support and click Service Center. You will see 
several options for contacting EMC Technical Support. Note that to open a service request, 
you must have a valid support agreement. Contact your EMC sales representative for 
details about obtaining a valid support agreement or with questions about your account.

Your comments
Your suggestions will help us continue to improve the accuracy, organization, and overall 
quality of the user publications. Send your opinions of this document to:

techpubcomments@emc.com

Bold Use for names of interface elements, such as names of windows, dialog 
boxes, buttons, fields, tab names, key names, and menu paths (what the 
user specifically selects or clicks)

Italic Use for full titles of publications referenced in text

Monospace Use for:
• System output, such as an error message or script
• System code
• Pathnames, filenames, prompts, and syntax
• Commands and options

Monospace italic Use for variables.

Monospace bold Use for user input.

[ ] Square brackets enclose optional values

| Vertical bar indicates alternate selections — the bar means “or”

{ } Braces enclose content that the user must specify, such as x or y or z

... Ellipses indicate nonessential information omitted from the example
6 EMC VNX Family Monitoring and Reporting 2.2 User Guide
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CHAPTER 1
Introduction

This introduction includes the following topics:

◆ Summary of VNX Family Monitoring and Reporting ....................................................  8
◆ Architectural Overview ............................................................................................  10
Introduction 7



Introduction
Summary of VNX Family Monitoring and Reporting

EMC VNX Family Monitoring and Reporting is a software solution that extends Unisphere 
element manager capabilities by providing unified performance and capacity trending 
information of VNX and Next-Generation VNXe storage systems. This solution 
complements Unisphere health alerts and Unisphere Analyzer.

VNX Family Monitoring and Reporting automatically collects Block, File, and VNXe storage 
statistics. It also collects configuration data and stores it in a database that can be viewed 
through dashboards and reports. This solution can retrieve information from one or 
several VNX®, Next-generation VNXe®, CLARiiON®, and Celerra® storage systems 
qualified for support. Monitoring and Reporting is a versatile solution to help you 
understand storage utilization and workload patterns. It also helps with problem 
diagnosis, trend analysis, and capacity planning.

The VNX Family Monitoring and Reporting web portal is a comprehensive dashboard that 
provides multiple ways to access reports quickly and effectively using the navigation tree, 
search engine, global views, and drill-down facilities. For example, the System Summary 
shows the hardware model, operating environment version, system-level aggregated 
capacity utilization, and performance overview. Drill-down into Block storage shows lower 
level reports such as pools, LUNs, FAST Cache, and FAST VP. The graphical user interface 
allows you to filter, sort, search, and link to other views to determine the cause-and-effect 
relationships.

The dashboard views are categorized by key topics such as Inventory, Performance, 
Capacity, Situations to Watch, Top N Reports, Service Levels, and Trending and 
Forecasting. These views include targeted and most active reports, technical graphs and 
tables, visual alerts against thresholds, key performance indicators, deviation analysis, 
and forecasting to help you plan for future growth. All reports display the latest available 
collected data and historical data. Historical data is aggregated over time as it ages 
according to the retention policy.

VNX Family Monitoring and Reporting provides a set of preconfigured reports, known as 
the ReportPack. You can export reports into various formats, change the report 
configurations, change the dashboard views, and save reports to your favorites.
8 EMC VNX Family Monitoring and Reporting 2.2 User Guide
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Dashboards and Reports

VNX Family Monitoring and Reporting includes the following features:

◆ Out-of-the box Dashboards summarize information in the form of graphs, charts, and 
tables. Dashboards enable you to quickly pinpoint utilization and performance 
problems. From this top perspective, you can drill down to underlying reports to get 
more detailed views of a selected component. Individual users can arrange the layout 
of the dashboard to suit business requirements.

◆ A multitude of specific reports present information specific to one component or a 
group of components. The web portal provides users with several tools to refine the 
presented data and visualize it from different angles for better troubleshooting.

Reports can run on-demand. Report options include graphs and tables and output formats 
include CSV, XLS, XML, and PDF.

Built-in dashboards and reports include:

For a summary of VNXe reports, refer to Appendix A.

VNX Block Reports VNX File Reports

Capacity utilization of one or multiple VNX 
systems

File storage capacity utilization of one or 
multiple VNX systems

Block services summary of one or multiple VNX 
systems

File services summary of one or multiple VNX 
systems

SP utilization and performance (File) Storage pool capacity 

Cache performance File system capacity. including snapshot 
utilization and compress/deduplication savings

FAST Cache performance File system capacity forecast

FAST VP performance by tier DataMover CPU utilization and performance 
(CIFS/NFS)

Storage pool capacity and performance, 
including thin oversubscription

DataMover file system capacity, including 
snapshot utilization and 
compress/deduplication savings

RAID group capacity and performance VDM file system capacity, including snapshot 
utilization and compress/deduplication savings

LUN capacity and performance Top N users performance (DataMover, 
CIFS/NFS)

Disk capacity and performance Top N file systems performance (DataMover)

Port utilization and performance Replication session (DataMover, VDM)

Top N active hot spots

Performance baseline deviation

Compressed LUNs Summary

SnapShots Summary
Summary of VNX Family Monitoring and Reporting 9
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Database and Analytics

As hundreds of raw metrics are collected from storage systems and stored in the database 
for aggregation, normalization, and correlation, Monitoring and Reporting continuously 
processes the data to perform statistical analysis and evaluate pre-configured KPI 
thresholds as Block, File, and VNXe metrics are collected.

Administration

The Administration area is where the Monitoring and Reporting administrator manages 
day-to-day tasks from a simple web interface. This allows you to manage user roles and 
profiles, monitor the health of the Monitoring and Reporting server, see the status of 
servers, execute tasks, configure Alerts and Chargeback, and perform install and upgrade 
operations.

Architectural Overview
The Monitoring and Reporting architecture includes the following components:

Please refer to Appendix B, “Communication Ports,” for the list of ports used by the 
application.

The Data Collector Collects data, in an agentless way, from one of multiple systems.

The Data Repository Stores the data collected from the data sources. The database module is 
self-maintaining and provides multiple automations. For example, data 
aggregation is performed for report acceleration and data retention is 
managed for storage optimization.

The Web Portal Displays operations, engineering, and management dashboards to users. 
Users have multiple ways to access information quickly and efficiently 
using a navigation tree, search engine, report wizard, or drill-down 
facilities.
10 EMC VNX Family Monitoring and Reporting 2.2 User Guide



CHAPTER 2
Installing

This chapter discusses information and procedures for the following topics:

◆ Environment and system requirements ...................................................................  12
◆ Installing on Linux...................................................................................................  14
◆ System start............................................................................................................  17
◆ Uninstalling ............................................................................................................  18
◆ Upgrading...............................................................................................................  18
Installing 11



Installing
Environment and system requirements
The host system on which VNX Family Monitoring and Reporting is installed must meet the 
minimum requirements outlined in the following sections.

Host system requirements

The VNX Family Monitoring and Reporting software must be installed on a Windows Server 
2008 R2, Windows Server 2012 R2, or a Linux (RedHat or CentOS) dedicated server. The 
operating system should be the latest version recommended by the vendor.

Naviseccli must be installed on the VNX Family Monitoring and Reporting host system for 
VNX systems as Naviseccli commands are used to communicate with the storage array. 
EMC recommends installing the latest version of Naviseccli for the latest storage system 
model which you are monitoring with Monitoring and Reporting. For more information on 
Naviseccli and operating environment compatibility, refer to the release notes for your 
storage system or the E-Lab Interoperability Matrix on EMC Online Support.

The host system must meet the following hardware requirements:

Monitoring and Reporting can run as a guest VM in a virtualized environment.

Browser Requirements

The VNX Family Monitoring and Reporting web portal is compatible with the following 
browsers:

◆ Internet Explorer 9 and 10

◆ Firefox (latest)

◆ Chrome (latest)

◆ Safari 5.1.1 or later

1 system 2 CPU cores, 8GB RAM, 200GB of disk space.

2-3 systems 4 CPU cores, 16 GB RAM, 400 GB of disk space.

Up to 10 systems 8 CPU cores, 32 GB RAM, 600 GB of disk space.
12 EMC VNX Family Monitoring and Reporting 2.2 User Guide
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Supported Platforms

VNX Family Monitoring and Reporting is compatible with array products listed in the 
following table:

Supported Languages

The VNX Family Monitoring Reporting software is available in the following languages:

◆ English

◆ French

For more information on setting user language preferences, refer to Edit user settings.

Installing on Windows 
To install Monitoring and Reporting on Windows:

1. Double-click the install icon.

2. On the Welcome screen, click Next.

3. Read the license agreement and click I Agree.

4. Confirm the default location of the program files or click Browse to choose a different 
location.

5. When the installation completes successfully, click Next.

6. Click Finish to close the set up wizard and to launch Monitoring and Reporting.

Model Operating Environment

VNXe 3200 VNXe OE 3.0

VNXe OE 3.1.0, 3.1.1

VNX 5200, 5400, 5600, 5800, 7600, 8000 OE for File 8.1

OE for Block 5.33

VNX 5100, 5300, 5500, 5700, 7500 OE for File 7.0, 7.1

OE for Block 5.31, 5.32

VNX Gateways VG10, VG50 OE for File 8.1

VNX Gateways VG2, VG8 OE for File 7.0, 7.1

CLARiiON CX4-120, CX4-240, CX4-480, CX4-960 FLARE OE 4.30

Celerra NX4, NS-120, NS-480, NS-960 DART OE 5.6, 6.0
Installing on Windows 13
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Installing on Linux 
To install Monitoring and Reporting on Linux:

1. Open a terminal session with the root user on your server.

2. Locate the installation package you downloaded.

3. Change the permissions of the installer so you can execute it. This example is for Linux 
64 bit:

# chmod +x setup-linux-x86_64-v22.sh

4. Run the script:

# ./setup-linux-x86_64-v22.sh

5. Read the EULA and press y to accept it. To scroll through the EULA, use the space bar.

6. Press Enter to accept the default directory or enter another location and y to confirm.

Enter the installation directory [/opt/VNX]:

7. Press Enter to accept the default account name or enter another one if you prefer.

Enter the user account we should create and use [vnx]:

8. Press Enter to accept the default location of service scripts or enter another location.

Enter the service scripts directory [/etc/init.d]:

9. Press Enter to accept the default location of runlevels scripts or enter another location.

Enter the runlevels base directory (containing rc[0-6].d/) [/etc]:

10. After the installation completes, read the Readme.

Deploying as a vApp

Note: Some of the vSphere menu navigation options described in this guide may vary 
slightly from the options you see in vSphere. Refer to the VMware documentation for 
details.

1. Download the VNX Family Monitoring and Reporting vApp files from EMC Online 
Support.

2. Open the vSphere Client and connect to the vCenter server that manages your VMware 
environment.

3. Select the resource pool where you want to deploy the VMs for VNX Family Monitoring 
and Reporting.

4. Select File > Deploy OVF template to launch the Deploy OVF Template wizard.

5. On the Source screen, locate the M & R ovf file and click Next.
Sample: VNX_MnR_2.2.0_1VM_vApp.ovf

6. On the OVF Template Details screen, review the details and click Next.

7. Review the license agreement, click Accept, then click Next.
14 EMC VNX Family Monitoring and Reporting 2.2 User Guide
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8. On the Name and Location screen:

a. Accept the default name, or type a name for the appliance.

b. Specify the location for the appliance within your VMware environment.

c. Click Next.

9. Select the host or cluster where you want to run the deployed template and click Next.

10. On the Storage screen, select the destination storage for the virtual machine files and 
click Next.

11. In the Disk Format step, select the storage space provisioning method and click Next.

Note: It is recommended that you use the Thin Provisioning format if the vApp will be 
deployed in a high-performance environment.

12. In the Network Mapping step, select a destination network that has an IP Pool 
associated with it for the VM and click Next.

13. In the IP Address allocation step, choose the IP allocation policy and IP protocol to 
use, then click Next.

14. In the Properties step, provide the values for the VM and click Next.

15. In the Ready to Complete step, review the list of properties for the appliance and click 
Finish. 

Note: You can also optionally select the Power on after deployment check box to power on 
the VM automatically once the deployment is complete.

Upgrading the vApp

Pre-requisites

◆ Note the name of the VNX M & R VM 

◆ Take snapshots of the VNX M & R VM. Ensure that the datastore where the VM is 
running has sufficient free space for the snapshots. Consult your VMware 
administrator for more information.

◆ Ensure that a login with root credentials is available.

1. Download the updated VNX Family Monitoring and Reporting vApp files from EMC 
Online Support.

2. Validate that the checksum matches by clicking the Checksum link on the download 
page and using a local utility such as md5sum to generate the checksum.

Note: Any changes that were made to the default firewall configuration by editing 
etc/sysconfig/SuSEfirewall2.d/services/mr will be overwritten during the 
upgrade with the original default configuration. Make a copy of this file so that you can 
again make the firewall configuration updates using the 
Upgrading the vApp 15
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usr/sbin/enable_firewall_port.sh script. This will preserve the custom 
configuration for all future upgrades. Run enable_firewall_port.sh for instructions 
on how to use the script. 

Update Linux Components

To update the Linux components, complete the following steps for the VNX M & R VM.

1. Upload the VNX_MnR_2.2.0.0_vApp_Update.zip file to a temporary directory 
on the VM using a tool such as SCP.

2. Log into the VM host as root.

3. Extract the zip file #unzip VNX_MnR_2.2.0.0_vApp_Update.zip.

4. Navigate to the applianceUpdate directory.

5. Run the applianceUpdate script ./applianceUpdate.

IMPORTANT

On the hosts, a firewall modification occurs. This modification may result in error 
messages such as FATAL: Could not load 
/lib/modules/2.1.101--0.35-default/modules/dep: No such file or 
directory after the modified firewall is reloaded, but before the upgrade script 
completes. These error messages can be safely ignored. 

Stage VNX Family M & R components on the VNX M & R VM deployed using the vApp 
Installer

1. Log into the VM as root.

2. Navigate to the usr/MnR_Source directory and run the post-install script: 
./post_install_sh

3. Answer the questions presented in the wizard.

The new packages are installed in the /opt/APG/Tools/Module-Repository 
directory. If you have an installation without any other Linux or Windows servers, 
your system is now prepared for update. If you have any additional Linux servers 
deployed using the VM vApp, run the steps above on each of the deployments.

Configuring the user process limits for Linux 
(Linux binary installs only)

For large deployments, increase the user process limits for the Monitoring and Reporting 
user account to a maximum of 65534. This modification enables Monitoring and 
Reporting services to open 65534 files and 65534 processes when needed.

1. Open a terminal session with the root user on your server.

2. Open the /etc/security/limits.conf file.

3. Add the following lines for the Monitoring and Reporting user (vnx or another name):
16 EMC VNX Family Monitoring and Reporting 2.2 User Guide
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vnx hard nofile 65534
vnx soft nofile 65534
vnx hard nproc 65534
vnx soft nproc 65534

4. Save the file.

5. Type the following commands from the /bin directory of the installation to restart 
Monitoring and Reporting services (for example, from the /opt/VNX/bin directory):

./manage-modules.sh service stop all

./manage-modules.sh service start all

5. Issue the following command to verify the changes:
# su vnx -c 'ulimit -n -u'

System start
At the end of the installation process, system services are started and your default 
browser is opened to the URL where you can start configuring your system for data 
collection.

If you installed VNX Family Monitoring and Reporting on a Linux server, your browser will 
not open automatically. Point your browser to http://<server-name>:58080/VNX-Config to 
access the configuration page, replacing <server-name> with the name or IP address of the 
server where you installed the software. Monitoring and Reporting is a web application. 
You can access the web portal from systems on the network that can communicate with 
the Monitoring and Reporting server at this URL: http://<server-name>:58080/VNX-MR.

IMPORTANT

The first time you log in, the default user name is admin and the default password is 
changeme.

See Chapter 3, “Administration tasks,” for detailed information on how to configure and 
troubleshoot your system.
System start 17



Installing
Uninstalling

To uninstall Monitoring and Reporting for Windows:
1. Go to Start > Control Panel > Uninstall a program.

2. Double-click on the program icon. Proceed through the uninstall wizard.

To uninstall Monitoring and Reporting for Linux:
1. Go to the executable directory

cd /opt/VNX/bin:

2. Stop services

./manage-modules.sh service stop all

3. Remove services

./manage-modules.sh service remove all

4. Remove the distribution

cd /opt
rm -Rf VNX

Upgrading

IMPORTANT

If your Naviseccli files are installed in a custom location other than the default [Example: 
C:\Program Files (x86)\EMC\Navisphere\bin\naviseccli], ensure you have reset the path to 
the correct custom location after an upgrade. See the Registered Systems Page for more 
information.

Version 1.x to 2.x

There are two different methods of upgrading from a 1.x to 2.x version of Monitoring and 
Reporting: “In-place upgrade” and “Fresh Installation” (on a new host system). Select the 
method that best suits your needs. 

Note: Chargeback will need to be reconfigured when upgrading to 2.x through either 
method.

In-place upgrade
The in-place upgrade for 1.x to 2.x versions of Monitoring and Reporting will preserve 
custom configuration settings including system settings, alerts, users, and scheduled 
reports, but will not preserve historical data collected by the 1.x version of Monitoring and 
Reporting. 

1. Download Monitoring and Reporting for the VNX Family 2.0 from EMC Online Support.
18 EMC VNX Family Monitoring and Reporting 2.2 User Guide
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2. Follow the procedures for installation for your host system, as described in “English” 
or “Installing on Linux”.

3. Reconfigure Chargeback, if previously set up on the 1.x instance.

IMPORTANT

Historical data from 1.x will be preserved on the 1.x host system in the following 
location: Databases/MySQL/Default/data/apg_bak. This data will not be fully 
readable by the 2.x instance of Monitoring and Reporting, but can be later moved to 
and accessed by a host system running Monitoring and Reporting 1.x. As this folder 
can take up considerable file space, it is recommended that you remove or archive 
this folder if you do an in-place upgrade to 2.x.

Fresh Installation
Fresh installation of Monitoring and Reporting 2.x will require a separate host system from 
that which is running Monitoring and Reporting 1.x. Running Monitoring and Reporting 1.x 
and 2.x on two separate systems is recommended if you need to preserve and access 
historical data from 1.x. You can discontinue use of the first host running 1.x once the 2.x 
instance has collected sufficient historical data for your system(s).

1. On the 1.x host system, stop the VNX Collector service. Leave all other services 
running.

2. On a new system, download Monitoring and Reporting 2.x from EMC Online Support.

3. Follow the procedures for installation for your host system, as described in “English” 
or “Installing on Linux”.

4. Reconfigure all previously customized settings, including system settings, alerts, user 
settings, Chargeback, and scheduled reports.

Version 1.x to 1.x and 2.x to 2.x 

To upgrade Monitoring and Reporting, follow the same procedure used for installation. The 
system will automatically recognize that a previous version of Monitoring and Reporting is 
already installed and will proceed in Upgrade Mode.

Note: After an upgrade, you will need to use the default credentials, user name admin and 
password changeme, when you initially log in.
Upgrading 19
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CHAPTER 3
Administration tasks

This chapter discusses administration tasks including:

◆ About Home Page ...................................................................................................  22
◆ Managing licenses ..................................................................................................  23
◆ Managing User Accounts.........................................................................................  24
◆ Viewing Storage Systems ........................................................................................  26
◆ Adding/Editing a System.........................................................................................  26
◆ Alerting...................................................................................................................  28
◆ Data Enrichment .....................................................................................................  31
◆ Backing up your system ..........................................................................................  35
◆ Retention parameters..............................................................................................  36

These functions are available only to the VNX Family Monitoring and Reporting 
administrator
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About Home Page
The home page is where you conduct certain administrative tasks related to your VNX 
Family Monitoring and Reporting software solution. These tasks include adding and 
managing systems and licenses, configuring global mail settings, and starting/stopping 
services. The home page shows the server system resource utilization, database storage 
utilization, and status of services that are performing various Monitoring and Reporting 
tasks.

The navigation on the left allows you to quickly go to the page dedicated to the specific 
action. 

Home View system status, system storage consumption, and service statuses. From the 
service section, you can click a given service to start or stop it.

Licenses Request permanent licenses, install and delete licenses.

Systems List configured systems with their main properties. From this section, you can 
click on a given system to edit it.

Add New Create a new system entry and open the corresponding configuration page.
22 EMC VNX Family Monitoring and Reporting 2.2 User Guide
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The home page also shows data storage usage and allows you to control the services 
required to operate the application. The following table lists the system services and their 
functions.

Managing licenses
When you first install Monitoring and Reporting software, temporary licenses allow you to 
work for 90 days. During this period, you must request permanent licenses and install 
them for continuous monitoring and reporting of your storage systems.

From the management page, click Licenses on the navigation tree to access licensing 
options.

From the licensing page, you can Request Permanent Licenses, Upload Licenses that you 
have received, see which licenses are installed, and Delete licenses if needed. The search 
box allows you to look for specific words in the license names or descriptions.

To add a license 1. Click Upload licenses.

2. Browse and select the zip file that you have received from EMC.

3. Click Ok.

To delete a license 1. Click the corresponding checkbox to select the license, or use All / Invert / None to 
refine your selection.

2. Click Delete.

Alerting Controls alert services

Backend Receives raw data from the collection service and prepares data to be 
stored in the database.

Collecting Controls data collection.

Database Database service.

Event Processing Receives raw data from collectors and computes TopN aggregates.

Gateway Communication gateway for Monitoring and Reporting services.

Scheduler Used to control processes that need to be run on a regular schedule.

Web Portal Web container hosting the user interface.
Managing licenses 23
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Managing User Accounts
VNX Family Monitoring and Reporting allows the creation of up to nine user accounts in 
addition to the default admin account, for a maximum of up to 10 users. Simultaneous 
user connections are unlimited. 

There are two types of users: Normal User and Global Administrator. There can be only one 
Global Administrator for each Monitoring and Reporting license. The Global Administrator 
role is the default role created when you install Monitoring and Reporting. The 
administrator can create and manage other users. 

Adding a new user 1. To add a new user, navigate to the Administration page and click Users.

2. Click New User.

3. Enter the required User Data fields. Note that Title, First Name, Last Name, and Email 
Address are optional fields. In order for a user to receive automated emails from 
Monitoring and Reporting, such as Schedule Reports, the Email Address field must be 
complete.

Edit an existing user 1. To edit an existing user, click on the user in the users list. 

2. Click Edit.

3. From the User Modification page, edit the User Data fields.

Additional User Account Management tasks are described in Table 1, “User Account 
Management Tasks”.

Table 1  User Account Management Tasks

IMPORTANT

To reset user passwords, follow the instructions in “Edit an existing user” to update the 
password fields under User Data.

Edit user settings 1. On the main dashboard page, click Settings.

2. On the User Data tab, edit user settings, including name, password, and email 
address.

3. Click Save.

User Management Task Description

Edit Edit User Data.

Copy Copy a user to a new row. You will be required to enter the User Data.

Test User Test and preview user settings by logging in as if you were that user.

Disable Disable a user. Disabled users cannot log into the system.

Delete Delete the user.
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Edit user reporting 
preferences

1. On the main dashboard page, go to Settings.

2. On the Preference tab, edit the default language and Report Auto Refresh Rate, then 
click Save.
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Viewing Storage Systems
The Systems section presents you with a global picture of the storage systems that are 
monitored by your application. Each defined system will have its entry in this table.

Click on a system to view detailed information or edit a system’s characteristics. The Add a 
New System button on the Registered Systems page or the Add New option of the 
navigation tree will open an empty configuration page where you can define a new system.

Adding/Editing a System
The Adding a System and Editing a System pages are where you specify the information 
required in order for Monitoring and Reporting to access your storage systems. You need 
to specify a unique name that will be used to identify this storage system and the type of 
data collection - Integrated Unified, Unified, Block-only or File-only - that should be 
applied to this unit. For Gateway systems, the data collection type should be File. Unified 
data only applies to integrated VNX systems that contain both block storage (SAN) and file 
storage (NAS) hardware components. Integrated Unified systems applies only to 
Next-Generation VNXe systems (VNXe3200). Mandatory fields are indicated with a red 
asterisk. Supported legacy CLARiiON CX4 and Celerra NS systems can also be added from 
this screen.

Note that it can take a few minutes before you can see information from a newly added 
system in the reporting portal. The software needs to poll the new system at least once to 
add metric information to the database.

When adding a system to Monitoring and Reporting, a Block or VNXe user account with the 
role of Operator is required to collect the configured Block data. A File local user account 
(such as nasadmin) is required to collect the configured File data. The selected user must 
be able to connect to the system using ssh for the collection mechanism to work, using 
group (role) administrator, fullnas, root, or storage. The VNX or CLARiiON array must be 
configured with “Statistics logging” enabled in order to provide all metrics to VNX 
Monitoring and Reporting.

Block Collecting Information:

File Collecting Information:

SP A/B IP The IP address of each storage processor (A and B).

User Scope Authentication scope. Global, local or LDAP.

Naviseccli Username Username to be used to connect to Unisphere.

Naviseccli Password Password to be used to connect to Unisphere.

Control station IP The IP address of the Control Station.

Username Username to be used to connect to the Control Station.

Password Password to connect to the Control Station.
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VNXe Collecting Information

Registered Systems Page

The Registered Systems page allows you edit the Naviseccli path and edit the polling 
intervals for both capacity and performance metrics (5, 15, or 60 minutes). The polling 
interval determines how often Monitoring and Reporting queries the storage systems for 
updated metrics. You can also Add a New System from this page, and manually refresh the 
data using the Retrieve missing information button.

Configuring Mail
VNX Family Monitoring and Reporting offers the option of emailing reports and alerts to 
users. This requires configuration of a valid SMTP (mail) server. 

1. In the main configuration page, click the Global Settings button.

2. In the SMTP Host box, enter the name or IP address of the mail server. This may 
require the help of your local system administrator, especially if the default port 25 
does not work or if the mail server requires a specific authentication scheme.

IMPORTANT

In order to receive emails, user profiles must include a valid email address. 

Host The IP address used to reach the VNXe server.

Username VNXe username.

Password VNXe password.
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Alerting
There are a variety of predefined alerts, which you can configure to trigger based on when 
certain performance thresholds are violated. You can also configure the alerts to trigger for 
only certain components, such as specific LUNs or SPs. Alerts are sent to Monitoring and 
Reporting users by email or captured by SNMP trap.

For example, for the LUN Response Time alert, you can set up an alert to trigger whenever 
a LUN response time is greater than 1 millisecond. Although the alerts are pre-defined, the 
threshold value and operator are set by the user. You can further configure this alert to 
trigger only when this threshold is surpassed for specific LUNs on specific systems.

There are five main components to configuring alerts: Configurable Data Filtering, where 
you can apply the alert to only certain components, Constant Comparator Operation, 
where the threshold condition is configured, Mail Action, where the email action is 
configured, SNMP v1Trap: SNMP Trap - Set, where the SNMP trap information is set, and 
SNMP v1 Trap: SNMP Trap - Clear, where the SNMP information is re-entered in order to 
clear the trap when the alert condition is no long occurring.

Note: Monitoring and Reporting does not support customization of community strings. 
The community string is enforced as “default”.

IMPORTANT

In order to receive email alerts, you must have email configured. Refer to “Registered 
Systems Page” for more information.

Enabling Alerts 1. Go to the Administration page.

2. Select Alerting under Modules > Miscellaneous. A new browser window will appear.

3. Click Alert definitions in the menu tree on the left, or click Local Manager in the 
central pane.

4. Click directly on the row for the alert and select Enable. You will see an Operation 
Successful pop-up message when the alert has been enabled. 

You will also notice that when clicking on the alert again, the Enable option will be 
replaced by the Disable option.

Configuring Alerts 1. Click on the alert name on the Alert Definitions page and select Configure. You can 
also click on the alert name in the alert tree to go to the configuration page for that 
alert.

2. In the Configurable Data Filtering section, you can enter the specific components 
to which to apply the alert threshold. 

a. To apply the an alert to all components, leave the Selection drop-down option set 
to all. 
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b. To apply the alert to only certain components, set the Selection drop-down to 
some. Click the Add values button. A pop up window will appear, displaying all 
components to which you can apply the alert. Use the checkboxes to select the 
components and click Ok. This window also has a search bar which enables you to 
search for your components more quickly.

For example, for the LUN Response Time alert, you can select which LUNs to which 
you want to apply the alert.

3. In the Constant Comparator Operation section, enter the Constant value of the 
threshold condition and the Operator. For the list of available operators, refer to 
Table 2, “Available Operators,”. For the list of constant value units for each alert, 
refer to Table 3, “Alert Constant Value Units,”.

4. In the Mail Action section, enter the email address of the user(s) to whom the alert 
should be sent. Recipient email addresses should be separated by a comma.

Table 2  Available Operators

Operator Description

< Less than

< = Less than or equal to

= Equal to

> Greater than

> = Greater than or equal to

! = Not equal to
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5. In the SNMP v1 Trap: SNMP Trap - Set section, enter the Host IP address and Port 
for the SNMP Trap.

6. In the SNMP v1 Trap: SNMP Trap - Clear section, reenter the Host IP address and 
Port. This will clear the trap when the alert condition is no longer being met.

7. Click Save.

IMPORTANT

Generally, you should not change the default Message template for the Alert emails. The 
contents of the message are designed to tell you exactly where the alert condition has 
been violated and the actual value which triggered the alert. For information on how to 
reset the Alert email message, refer to “Resetting the Alert email text”  on page 51.

Available Alerts

Table 3  Alert Constant Value Units

Alert Name Unit

Data Mover Processor Utilization %

File System Percent Subscribed %

LUN Response Time milliseconds

Storage Pool Percent Subscribed %

Storage Processor Dirty Pages Utilization %

Storage Processor Utilization %
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Data Enrichment
Data Enrichment allows you to add metadata to the metrics collected by Monitoring and 
Reporting in order to enhance, or enrich, the data. Data Enrichment is located on the 
Administration page under Centralized Management.

Chargeback

Chargeback is a feature which uses Data Enrichment to determine the data cost-of-service 
of a business unit or application and displays it in the form of Chargeback Reports. There 
are two main components to configuring Chargeback: Business Unit and Cost. You can 
associate particular LUNs on an array with a business unit, application, and application 
owner. You then assign a cost value per gigabyte used for LUNs belonging to a certain RAID 
type and tier. Optionally, you can also specify cost per LUNs of a certain RAID type and tier 
on a specific array model. Chargeback will apply this cost to each gigabyte of data used by 
a LUN that meets the criteria you have defined for each business unit. 

For example, logical unit number (LUN) 0 can be associated with the Development 
Business Unit. In the Cost section, you can configure any LUNs on a VNX5700 array with a 
RAID5 RAID Type which are part of the Performance Tier to incur a cost of $3.14 per GB 
used. If LUN 0 is a RAID5 LUN on the Performance tier on a VNX5700 array, the 
cost-of-service of the Development Business Unit will be $3.14 per GB used. The 
Chargeback Reports display the cost of service over time.

Multiple LUNs can be associated with a single business unit. Chargeback reports calculate 
the total cost-of-service of each business unit. For example, if a business unit is configured 
to have multiple LUNs, the cost per GB of each of those LUNs will be added to the total 
cost of service of the business unit.

You can also associate mixed LUNs with a particular business unit. Chargeback will 
calculate cost based on the percentage of storage allocated for that LUN by tier and RAID 
type.

There are several Chargeback reports which represent cost-of-service. These include Top 
10 Applications by Cost, Top 10 Applications by capacity, Cost distribution by business 
unit, Cost per Business Unit, and Cost per Business Unit and Application.

To add a new Business Unit or Application to Chargeback:

1. Go to the Administration page.

2. Select Data Enrichment under Centralized Management.

3. Click localhost :: Default :: Data-Enrichment from the navigation tree on the left.

4. Expand the Business Unit section.

5. Add a new row by clicking the add/delete rows icon in the left-most column of an 
existing row and selecting Insert before or Insert after, depending on your 
preference
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6. Complete the rows according to the following table:

7. Click Save.

To enter Cost:
1. Expand the Cost section. Rows will be pre-populated for each RAID Type and Tier 

combination. You will need to update the System Model and Cost column entries 
for each row.

2. Click an existing row in the System Model column. Enter the device model of the 
array. To apply the same Chargeback costs to each RAID type and tier for all array 
models, leave the default value of .* in this column.

Table 4  Adding a Business Unit and Application

Column Label Value

System Name Add the name of the system.

Object Name Add the name of the LUN. Use the format “Logical Unit 
Number X” where X is the LUN number.

Business Unit Add the name of the Business Unit.

Application Name Add the name of the application.

Application Owner Add the name of the owning SP for the LUN.
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3. Click an existing row in the Cost column. Edit the default value to the appropriate 
cost per GB for that RAID type on that tier. 

Note: Cost values cannot include decimals.

4. Repeat steps 1-3 for the remaining rows as needed.

5. Click Save. 

To add new rows to Cost:
1. Add a new row by clicking the add row icon in the first column of an existing row 

and selecting Insert before or Insert after, depending on your preference.

2. Complete the rows according to the following table:

Table 5  Adding Cost

Column Label Value

System Model Enter the device model of the array.
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3. Click Save.

IMPORTANT

If you are configuring Chargeback for mixed LUNs, be sure to associate costs with each tier 
and RAID type combination for those LUNs in the Cost section.

Do not use the delete buttons to remove any existing columns from Chargeback. Doing so 
may prevent the Chargeback reports from working correctly. Do not use the New Tagging, 
Add new key or Add new property buttons. 

RAID Type Enter the RAID Type of the LUNs to which you are applying a cost 
value:
• RAID5
• RAID6
• RAID10

Tier Name Enter the Disk Type of the LUN to which you are applying a cost 
value:
• Capacity
• Performance
• Extreme Performance

Cost Enter the cost value per gigabyte used by LUNs on that model 
and Tier with that RAID type.

Table 5  Adding Cost

Column Label Value
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Backing up your system
It is essential that you back up the VNX Family Monitoring and Reporting solution on a 
regular basis. We recommend you back up data at the end of every business day and save 
the backed up information off-site.

The backup of the Monitoring and Reporting solution consists of two important parts: 
backing up the database and backing up the configuration files. 

Backing up the database

Backing up the database requires the tables to be locked while the backup engine reads 
them. This can be done by using a script within the solution (in the bin directory) and 
periodically scheduling the task according to your needs. This process should be run 
overnight as the tables will not be updated with new values until the backup is finished. 
The script will lock the tables for two hours and unlock them automatically when the timer 
expires. Data collected during the backup operation is queued by the backend process 
and inserted in the database as soon as the lock is released.

Here is the list of recommended databases to back up:

◆ apg
◆ master
◆ storage
◆ topology

Backing up the configuration files

The second important part of the solution is the set of configuration files. The following is 
a list of sensitive directories to consider for backups:

◆ Databases
◆ Custom

Backing up these two directories will back up the following configuration files:

◆ Retention parameters
◆ Collector configurations
◆ Filters
◆ Listener configurations
◆ Databases connection strings
◆ Third party connections parameters
◆ Scripts
◆ Logs
◆ Temporary files
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Retention parameters
Monitoring and Reporting collects new metrics every 5 minutes. This raw data is 
accumulated in hourly, daily and weekly aggregates that are used to display data on 
various time horizons. The retention policy for raw data and aggregates can be found in 
the table below. For example, Monitoring and Reporting allows you to report on weekly 
data for up to four years in the past.

Accumulation period Retention period

5 minutes (raw data) 15 days

hourly 92 days

daily 365 days

weekly 4 years
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CHAPTER 4
Viewing Reports

This chapter discusses the following topics:

◆ The web portal ........................................................................................................  38
◆ Search for components ...........................................................................................  40
◆ Display options.......................................................................................................  41
◆ Export reports .........................................................................................................  43
◆ Report tools ............................................................................................................  44
◆ Scheduling Reports.................................................................................................  47

These features are available to all VNX Family Monitoring and Reporting users.
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The web portal
On the left panel of the main page is a report tree where reports are organized into parent 
and child relationships. You can click any report name in the tree to display the 
corresponding report on the right.

The menu bar on the top right of your display offers a collection of tools:

Search for reports Look for a specific report using a combination of keywords.

Display options Change the report time and time range settings

Export reports Export the currently displayed report into a common format.

Report tools Access the wizard and control favorites.
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The report tree

The report tree on the left of the page is a 
dynamic hierarchical tree you use to 
navigate nodes.

You can browse the tree by clicking each 
entry, node icon, or node name, which 
displays that report in the main page 
area.

To expand or collapse nodes to view or 
hide their children, click the arrow for the 
entry or double-click the node icon or 
name.

You can resize the report tree panel by 
dragging the border. 

Double-click the right edge of border to 
minimize or restore the panel to its 
default size.

Report tree elements:

Favorite reports Links to other reports in the template section of the report tree. You can add 
favorites as you browse the tree.

Summary and Details Preconfigured templates accessed by all users. Each of these reports is common 
to all users who access them.

Scheduled Reports Reports that are automatically generated at specified times.

My Reports Displays user-configured reports. For example, reports with customized visual 
thresholds.
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Search for components
You can use Search to quickly access a particular system or component. You can search by 
system name, model, or IP. The Search box is at the top of the dashboard. 

1. In the Search box, type the keywords for the component and press Enter.

2. Click on the name of the system or component, or click Show all, and then the name of 
the system or component for which you want to view reports.
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Display options
Information is presented in pre-configured graphics or tabular reports. The Display menu 
on the top of the dashboard allows you to change the display options for finer 
examination.

To change the report display options

1. From the Time Selection area, choose the type of aggregation the report uses and the 
time range it covers.

2. From the Display ___ values list, choose an aggregate time period.
Real-time values are aggregated as they are collected. Other aggregation time periods 
are available. The defaults can be changed by your administrator. The defaults are:

• real-time: the real collected values
• 1 hour: 1 hour aggregates
• 1 day: 1 day aggregates
• 1 week: 1 week aggregates

3. From the Using ___ Aggregation list choose the type of aggregation you want to use.

4. From the time range list, select the time period the report will cover. You can use the 
Time Range Quick Switch arrows to choose the previous or next periods.

5. Choose a value from the Over field if you are using a custom range.

• Previous: selects the entire previous range. For example, the previous day is from 
midnight to the midnight the day before, and the previous one month includes the 
entire month's time, so if it is now September 10th the period would include all of 
August.

• Last: selects one range back from now. For example, the last day extends from the 
current time back 24 hours, and the last month extends from the current day back 
a period of one month.

• Current: selects the current range. For example, the current day extends from the 
last midnight through to the current time and forward to the next midnight, and the 
current month extends from the first of the current month to the last day of the 
month.

6. From the second field, select a time range. You can choose a pre-defined value or 
period. For greater accuracy, you can select custom or calendar.

• For calendar, specify the start and end times of the report.
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• For custom, specify a duration using numbers and units. There is no limit to the 
number of units, but each unit can be present only once. For example, 1h45m is 
translated as 1 hour and 45 minutes.

7. To lock the time frame, click the lock icon. If you lock the time frame, the time 
selection parameters that you chose are applied to every report you view during the 
current session. This can be used for obtaining snapshots-in-time in order to compare 
equivalent graphs for a device.

8. From the Actions area, choose the actions you want to take. Click Apply or your 
changes will not take effect.

• Choose View in Full Page to display only the contents of the reports currently in the 
page area in a new browser tab or window. Other user interface elements, 
including the report menu, do not appear.

• Choose Revert to Default to revert the report to its default settings. The Revert to 
Default option can also be used to refresh the report that is currently displayed.

Note: For Heat Map reports, you cannot click directly on the graphical interface to change 
the view or parameters. The default view is static.
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Export reports
Reports can be exported into various formats. The export formats available will vary 
slightly from report to report. Unavailable export options will be greyed-out.

To export a report

1. Select the node for the report you want to export.

2. On the Report menu, click Export.

Export formats

PDF document Creates a PDF and opens it in a window where you can save it or print it.

CSV format Exports the report in a CSV file. If this is a multipart report, each part is 
prepended with a commented line containing the tile of the part. For 
graphs, data is exported according to the graph type.

XLS format Exports the report in an XLS file. If it is a multipart report, each part is 
exported in a separate sheet. For graphs, data is exported according to 
the graph type. If you choose XLS 1 column, all of the values are 
displayed in one column.

PNG, JPEG or SVG image Creates an image of the report's first graph. If there is no graph on the 
exported report, an empty image is generated.

XML format Exports the report as an XML file.
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Report tools
The Tools menu gives you access to the Report Wizard and has tools for printing, emailing 
reports and adding them to your Favorites.

To access report tools

1. Select a report node from the tree.

2. On the Report menu, click Tools.

Report tools

Report Wizard Opens the Report Wizard from which you can create a new report.

Show Report URL Replaces the current URL with the complete report URL. This enables 
you to create a bookmark for this page or directly link to it.

Print this Report Generates the report in printable format.

Add to Favorite Reports Adds the current report to the Favorite Reports. These reports are 
listed on the top of the tree for quick access.

E-mail me this Report Generates the report and sends it as a PDF attachment to the email 
address configured in your settings.

Schedule this Report Generates the report at scheduled intervals and sends it as a PDF 
attachment to the email address configured in your settings.
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The Report Wizard

You can use the Report Wizard if you are troubleshooting an issue and you want to access 
data quickly. This is also a helpful tool to compare metrics for troubleshooting purposes.

To use the Report Wizard

1. On the Tools menu click Report Wizard.

2. From the View Type list select a view type. The available views are defined by the 
system’s administrator.

3. In the Available Elements area, select elements to filter on. You can click the filter icon 
and start typing the name of an element to filter the list. Continue to choose elements 
until you define all the elements you want included.

4. If you can select more metrics to add to the report, the Add Metrics button becomes 
available. You can click it and repeat steps 3 and 4 until you have all the metrics you 
want to add to your report.

5. Click Run to generate the report.
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Example of creating a report with the Report Wizard

This example shows how to create a report that displays CPU utilization for a number of 
Data Movers.

1. On the Tools menu click Report Wizard.

2. Choose these options:

• Devices: Select a serial number.
• Type: DataMover.
• Devices: Select all.
• Component Types: Processor.
• Components: CPU/0.
• Available Metrics: CurrentUtilization.

3. Click Run. You can save the report to My Reports to rerun it.
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Scheduling Reports
Reports can be scheduled to be generated at specific times and delivered by email to 
recipients as PDFs. Whenever a report is scheduled to be generated, it queries the 
database for the latest data.

To schedule a report:

1. Browse to the report you would like to schedule using the Report Tree.

2. Go to Tools > Schedule this Report.

3. On the Scheduling tab of the New Scheduled Report window, enter the name of the 
scheduled report, select how frequently the scheduled report should generate, 
and select the time zone.
Scheduling Reports 47



Viewing Reports
4. On the Email tab, enter the email addresses of the recipients for the scheduled 
report.

5. Click Save.

Note: Scheduled reports maintain the default display settings. To schedule a report with 
modified display settings, such as a custom time range, click Save modified report rather 
than Save.

Modifying a 
scheduled report

1. In the report tree, click Scheduled Reports. A list of scheduled reports will display 
in the main window.

2. Click on the name of the report you want to modify. A list of several options will 
appear, including Edit. Click Edit to modify the report settings.

3. On the Editing Scheduled Report screen, update the report name, schedule, and 
email recipients as needed. Click Save.
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CHAPTER 5
Troubleshooting

The content of this document describes the paragraph tags, character tags, and 
cross-reference formats supported in this chapter template.
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◆ Resetting Alerts.......................................................................................................  50
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Common Issues
The following table lists common issues:

Resetting Alerts
Resetting alerts can be used to reset the configuration for all alerts, including the alert 
email template. To reset only the alert email text, refer to “Resetting the Alert email text”  
on page 51.

IMPORTANT

Resetting the alerts will remove any existing alert configuration. For example, if you have 
configured some alerts to trigger for only certain components, such as only certain LUNs, 
this configuration will be removed when you reset all alerts.

On Linux:
1. Remove the existing alert configuration file:

rm/opt/VNX/Backends/Alerting-Backend/Default/conf/alerting.xml

2. Update the module, which will reinstall the configuration file:

/opt/VNX/bin/manage-modules.sh update alerting-backend

3. Stop and restart Alerting services. From the Monitoring and Reporting Home page, 
Select Alerting > Stop Process.

4. Select Alerting > Start Process.

No data or partial data is 
showing in the reports

Ensure that:
• No firewall is blocking access between the server running data 

collection and storage systems
• All Monitoring and Reporting services are up and running,
• Database storage has disk capacity
• The server date and time are accurate
• Your storage systems are available and accessible for the 

application

Cannot login to the portal
Ensure that:
• You are accessing the right URL and port: 

http://portal_ip:58080/VNX-MR
• All passwords are case sensitive. Confirm that you do not have 

CAPS LOCK on and that you are entering your password with the 
correct case.

The portal page does not 
appear

Ensure that:
• All Monitoring and Reporting services are up and running
• You tried the portal IP instead of its hostname in the URL
• Your browser proxy settings are correct (check with your local 

administrator)

A licence error appears at 
login page

Note the error message and contact support.
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On Windows
1. In Windows Explorer, navigate to Program Files > VNX > Backends > Alerting-Backend > 

Default > conf. 

2. Delete the existing alert configuration xml file alerting.xml.

3. Create a new alert configuration file by opening a command prompt window and 
entering the following command:

/opt/VNX/bin/manage-modules.sh update alerting-backend

4. Stop and restart Alerting services. From the Monitoring and Reporting Home page, 
Select Alerting > Stop Process.

5. Select Alerting > Start Process.

Resetting the Alert email text

1. Select the alert for which you want to reset the email text.

2. Expand Mail Action: Mail template. Enter the following text in the Message field:

PROP.'device' PROP.'parttype' PROP.'part' has exceeded the 
threshold, the current value is VALUE PROP.'unit'

3. Click Save.

Table 6  Alert email template variables

Variable Description Example

device System Name Array 123

parttype Component type LUN

part Specific component LUN 101

unit Current value which 
violated the alert 
condition, triggering the 
alert

If alert condition is LUN 
Response Time greater 
than 1 millisecond, the 
actual unit value would be 
any value over 1 ms
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Figure 1  Alert email example
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APPENDIX A
Available reports and metrics
VNX Block/CLARiiON (All Reports)

Parent Report Name Description

VNX Block / CLARiiON Storage Processor 
Utilization (%)

Percentage of time that the SP was busy serving incoming 
requests. 

Storage Processor 
Utilization (%)

Dynamic 
expansion on all 
controllers

Per controller CPU usage for both Storage Processors A and B. 

VNX Block / CLARiiON VNX Block Arrays 
Summary

Raw Capacity Total, Raw Capacity Free, Usable Capacity, Logical 
Free Capacity and Element in Problem.

VNX Block Arrays 
Summary

Block Usable 
Capacity

Distribution of used and free space for all arrays.

VNX Block Arrays 
Summary

Distribution by 
Model

Distribution of arrays according to their model (CX, VNX,...).

VNX Block Arrays 
Summary

Distribution by 
Version

Distribution of arrays according to their FLARE or Block OE 
version.

VNX Block Arrays 
Summary

Dynamic 
expansion on all 
arrays

A complete report showing volume distribution per array.

VNX Block / CLARiiON Inventory Complete inventory of all monitored components.

Inventory Dynamic 
expansion on 
device types

Inventory of all Arrays, SPs, LUNs, RAID Groups, Storage Pools, 
Storage Groups, Disks, Hosts, Ports and Applications.

VNX Block / CLARiiON Performance Storage Pools IOPS Bottleneck, LUN Performance Bottleneck, 
Storage Processor Write Cache, LUN Read Cache, TopN & 
Exceptions.

Performance Storage Pools IOPS 
Bottleneck

Read / Write IOPS Capability.

Performance LUN Performance 
Bottleneck

Performance report listing all Logical Unit numbers' Utilization 
and queue length.

Performance Storage Processor 
Write Cache

A mixed report combining Write Cache Utilization, Storage 
Processors Flush Ratio, Watermark Flush Rate, LUN Hit Ratio.

Performance LUN Read Cache Pre-fetched percentage used and hit ratio per LUN.

Performance TopN & Exceptions IOPS, Performance Analysis, Disk and LUNs Errors, Disk 
Fragmentation.

Performance Disk Utilization 
Heat Map

This report shows disk utilization for a given array.

Performance SP Utilization Heat 
Map

This report shows SP utilization by array.

VNX Block / CLARiiON Capacity Planning Space Capacity Planning, Storage Pool Capacity Planning.
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Available reports and metrics
Capacity Planning Space Capacity 
Planning

This report shows Provisioned Usable Capacity.

Capacity Planning Storage Pool 
Capacity Planning

This report shows when you should expect an array to reach its 
full disk capacity.

VNX Block / CLARiiON Health Arrays Compliance Forecast, Broken Disks.

Health Arrays Compliance 
Forecast

This report shows disk arrays availability and offers SLA results 
for the last month.

Health Broken Disks List of all broken disks. If no data is available in this list, there 
are no known broken disks.

VNX Block / CLARiiON Chargeback 
Reports

Calculates cost-of-service of business units

Chargeback Reports Top 10 Application 
by Cost 

This report displays the top 10 most costly applications.

Chargeback Reports Top 10 Application 
by Capacity

This report displays the top 10 applications by provisioned 
usable capacity.

Chargeback Reports Cost distribution 
by Business Unit

This report shows the distribution of overall cost among the 
business units.

Chargeback Reports Cost per Business 
Unit

This report displays the cost per business unit over the last four 
months.

Chargeback Reports Cost per Business 
Unit and 
Application

This report displays the cost per business unit, application, and 
application owner over the last four months.

Parent Report Name Description
54 EMC VNX Family Monitoring and Reporting 2.2 User Guide



Available reports and metrics
VNX File / Celerra (All Reports)

Parent Report Name Description

VNX File / Celerra VNX File CPU 
Utilization (%)

Per File/Celerra Server Processor Utilization in percentage.

VNX File CPU Utilization 
(%)

Dynamic expansion 
on all servers

Graph report showing CPU usage of each File/Celerra server.

VNX File / Celerra Protocol Overview / 
DM

Number of opened files, total calls (ops/s) per server, according to 
protocol.

Protocol Overview / DM Dynamic expansion 
on all servers

Number of opened files, total calls (ops/s) per server, according to 
protocol.

VNX File / Celerra VNX File Summary Displays a report on Total IO and severity per Serial Number/Device.

VNX File Summary Dynamic expansion 
on serial numbers

Dashboard showing Data Movers, Storage pools, File Systems, IO 
and Throughput.

VNX File / Celerra Capacity File system usage forecast.

Capacity All Filesystems Usage forecast and prediction per File System.

Capacity Deduplication Report showing saved space due to deduplication per File System.

Capacity Filesystems and 
Savvol Utilization

Utilization and Savvol stats for all File Systems.

Capacity Filesystsm Used 
Forecast

Total File System usage trending for the last week.

Capacity Savvol Defined Savvols and their capacity.

VNX File / Celerra Performance Celerra's IO and throughput information, per server.

Performance CIFS open 
Connections

The number of open connections over the last day.

Performance CIFS open Files The number of open files over the last day.

Performance CIFS Ops/s CIFS operations per second over the last day.

Performance NFS Ops/s NFS operations per second over the last day.

Performance Top 5 CIFS users This table report shows a list of top CIFS Read/Write users.

Performance Top 5 NFS clients This table report shows a list of top NFS Read/Write users.

VNX File / Celerra Inventory Number of Data Movers, File systems, Shares and CS.

Inventory Data Movers Status, uptime, CPU and memory utilization.

Inventory FileSystems Utilization, size and throughput.

Inventory NFS Shares Name, path and server for each share.

Inventory CIFS Shares Name, maximum users, path and server.

Inventory ControlStation Control stations with their availability.

Inventory System Systems with their availability.
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VNXe (All reports)

Parent Report Name Description

VNXe Capacity

Capacity Raw Capacity Displays raw capacity by:
• Configured Usable: Configured capacity that is available for data 

storage.
• Hot Spare: Capacity of all hot spares on the array.
• RAID Overhead: Array capacity used to support RAID protection 

overhead.
• Unconfigured: Total capacity that is available for the creation of 

LUNs, RAID groups, storage pools or hot spares.

Capacity Usable Capacity Displays usable capacity by:
• Free: Unbound data devices and SAVE devices, unmapped 

and/or unmasked thick LUNs.
• Pool Free: Unwritten space within pools and unbound capacity 

within RAID groups.
• Used For Block: Capacity that is made available to storage area 

network.
• Used For File: Capacity that is made available to network attached 

storage.

Capacity Used Capacity by Purpose Displays the capacity of the system as used for the following 
purposes:
• Local Replica Used: Array capacity that has been mapped, 

masked, and configured as local replicas. This capacity is 
commonly used for testing and backup.

• Primary Used: Array capacity that has been mapped, masked, 
and configured for the primary storage of application data. This 
does not include copies.

• Remote Replica Used: Capacity used for remote copies, 
commonly for disaster recovery.

• System Used: Capacity reserved for use by the array for internal 
operations.

Capacity Usable Capacity Trend Displays the following capacity types over time:
• Block Used Capacity: Total capacity used by Block Services.
• File Used Capacity: Total capacity used by File Services.
• Free Capacity: Total free capacity.
• Pool Free Capacity: Free capacity within storage pools.

Capacity Usable Capacity by Pool Displays capacity by storage pool.

Capacity Usable Capacity by Service Level Displays capacities for each service level. Service level is based on 
disk type, disk size, RAID type and FAST cache status 
(enabled/disabled). For FAST LUNs, Service Level is based on pool 
name, tiering policy name, and FAST cache status 
(enabled/disabled). Service levels include:
• Platinum: Flash Drive
• Gold: Fibre Channel, RAID-1
• Silver: Fibre Channel, RAID-5
• Bronze: SATA Drive
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Available reports and metrics
Capacity Storage Capacity Presented to NAS • Disks Used: Storage Capacity of production file systems and their 
overhead, storage capacity of SavVols and Free NAS Pool 
capacity.

• Free Capacity on Used Disks: Storage Capacity of free partitions, 
free metavolumes and free space on partially used NAS Disks.

• System Resource: Storage Capacity of NAS Disks used for internal 
file systems.

• Unused Disks: Storage Capacity of non-partitioned NAS Disks.

Capacity NAS disks used breakdown • Usable File System: Storage capacity of production file systems 
on NAS Disks or NAS Pools.

• NAS Pool Free: Free NAS Pool capacity that is available to create 
production file systems and SavVols.

• Usable SavVol: Storage capacity of SavVols on NAS Disks or NAS 
Pools.

• File System Overhead: Reserved overhead capacity to support a 
production file system.

Capacity NAS File systems Usage • File System Used: Used capacity of production file systems.
• NAS Pool Free: Free capacity of production file systems.

Capacity Storage Processor Utilization Percentage of time that the SP was busy serving incoming requests.

Performance NAS Servers Displays NAS servers and their attributes. 

Performance LUN / Summary Displays list of LUNs and attributes, LUN Groups, and LUN 
performance.

Performance Disks / Summary Displays list of disks and attributes, 

Performance Storage Pools Displays all storage pools and their attributes, including: capacity, 
used disks, FAST VP Capacity, and FAST VP Movements by Tier.

Performance File Systems / Summary Displays File Systems and their attributes, including capacity and 
deduplication.

Performance Throughput Displays system read and write throughput.

Performance Shares Displays all shares, including type and associated server.

Performance CIFS/NFS Performance / Summary Displays CIFs and NFS servers and performance attributes, including 
Throughput, IOPs, Operations, Connections, and Open files.

Performance FAST Cache / Summary Displays FAST Cache attributes including Cache Dirty pages by 
storage processor, FAST Cache valid elements, Total Cache Dirty 
Size, Total Cache Throughput/ IOPs

Performance FAST VP / Summary Displays FAST VP attributes, including Move Down Capacity, Move 
within capacity, and Moving up capacity.

Parent Report Name Description
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APPENDIX B
Communication Ports

The following table lists IP ports used by VNX Family Monitoring and Reporting services. 
TCP port 58080 must be open between browsers and the VNX Family Monitoring and 
Reporting server for browsers to access the application.

The following table lists IP ports used by VNX Family Monitoring and Reporting to access 
arrays. These ports need to be opened from Monitoring and Reporting to VNX and VNXe 
arrays.

Port Service

TCP/2000 Backend

TCP/2001 Backend

TCP/48443 Gateway

TCP/53306 Database

TCP/58080 Web Portal

Port Technology

TCP/443 naviseccli (SP IP) and XML/API (CS IP)

TCP/22 SSH (VNX File CLI)
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